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Features
Printer Tour

Printer Features
The Phaser 3500 Laser Printer embodies a multitude of features to meet your printing needs:

Great performance and superior print quality
Letter: 35 pages per minute (ppm) with 1200 x 1200 dpi image quality
A4: 33 ppm with 1200 x 1200 dpi image quality
Up to 288 MB RAM memory

Flexible paper handling
Optional 500-Sheet Feeder (including tray)
2-sided printing with Phaser 3500DN configuration to automatically print on both 
sides. If you use Phaser 3500B and Phaser 3500N configurations, you can print on 
both sides when you install an optional duplex unit.
A wide variety of productivity features
Easy to replace print cartridge
CentreWare IS printer management software helps manage, configure, and 
troubleshoot the printer from your computer.
Status Monitor provides on-screen notification and troubleshooting information.

Available Configurations
The Phaser 3500 Laser Printer is available in three configurations:

Features Printer Configuration

3500B 3500N 3500DN

Maximum Print Speed (pages per minute) 35 ppm 35 ppm 35 ppm

Memory (Standard) 
Up to 288 MB Optional

32 MB 32 MB 32 MB

PostScript and PCL Fonts Yes Yes Yes

Default Resolutions (dpi) 600 x 600 dpi 600 x 600 dpi 600 x 600 dpi

500-Sheet Feeder Optional Optional Optional

Network Interface Optional Standard Standard

Automatic 2-Sided Printing (Duplex) Optional Optional Standard
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Front View

Rear View

Printer Options and Supplies
The following printer options and supplies are available for Phaser 3500 printers:

1. Control Panel

2. Control Board cover

3. On/Off Switch

4. Paper Quantity Gauge

5. Tray 2

6. Tray 1 (MPT) Release

7. Tray 1 (MPT)

8. Paper Output Support

9. Output Tray

10. Print Cartridge

1. Rear Door

2. Duplex Unit (optional for Phaser 3500B and
Phaser 3500N)

3. Power Cord Receptacle

4. Optional Tray 3 Cable Connector

5. IEEE 1284 Parallel Port

6. USB Port

7. Network Port (option for Phaser 3500B)

Options and Supplies

Item Part Number

64 MB additional RAM memory 097S03389

128 MB additional RAM memory 097S03390

256 MB additional RAM memory 097S03391

Network Interface Card (NIC) 097S03386

Duplex Unit 097S03387

500-Sheet Feeder (includes tray) 097S03385

Standard-Capacity Print Cartridge (6,000 pages @ 5% area coverage) 106R01148

High-Capacity Print Cartridge (12,000 pages @ 5% area coverage) 106R01149
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Control Panel Layout
The control panel has three components:

Multi-colored Light Emitting Diode (LED) light
Alphanumeric display
Six-button cluster.

The alphanumeric display provides status messages and control panel menus.

Error and Warning Messages
When there is a problem with the printer, the control panel LED (2) blinks orange for an error 
and a warning. An error or warning message is displayed in the Alphanumeric Display (1). 

Menu Map
The “Menu Map” is a visual representation of the control panel settings and information 
pages.

To print the “Menu Map”:

1. On the control panel, press the Menu button, then press the OK button to select 
Information.

2. Press the OK button to print the Menu Map.

1. Cancel button

2. Return button

3. On-line/Data/Error LED

4. Menu button

5. Status/Error Messages and Menus

6. Up Arrow button

7. OK button

8. Down Arrow button
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Information Pages
Your printer comes with a set of information pages that helps you solve printing problems and 
obtain the best results from your printer. You can access these pages from the printer’s control 
panel.

To print information pages:

1. On the control panel, press the Menu button, then press the OK button to select 
Information.

2. Select Info Pages, then press the OK button.

3. Select the appropriate information page, then press the OK button to print.

Note
Print the “Menu Map” to see other information pages available for printing.

Sample Pages
Your printer comes with a set of sample pages which demonstrate different functions.

To print sample pages:

1. On the control panel, press the Menu button, then press the OK button to select 
Information.

2. Select Sample Pages, then press the OK button.

3. Select the desired sample page, then press the OK button to print.
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Printer Drivers
Printer drivers enable your computer and printer to communicate and provide access to printer 
features. Xerox makes driver installation easy with its Walk-Up Technology. For more 
information about printer drivers, see the video at www.xerox.com/office/drivers.

Available Printer Drivers
Xerox provides drivers for a variety of page description languages and operating systems. The 
following drivers are available: 

Driver Source Description

Windows PCL6 Driver CD-ROM and 
Web

The Printer Command Language driver is 
recommended to take full advantage of your 
printer’s custom features. (Default driver)

Windows PostScript Driver CD-ROM and 
Web

The PostScript driver can be used for 
applications requiring PostScript.

Macintosh OS Driver CD-ROM and 
Web

This driver enables printing from a Macintosh 
with Mac OS 9.x or Mac OS X, version 
10.2~10.3.

UNIX Driver Web only This driver enables printing from a UNIX 
operating system.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=driver&Language=english
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Printer Driver Features
The following chart displays the Xerox driver features that are available with specific 
operating systems.

Remote Control Panel
The Remote Control Panel is a Windows utility that enables you to:

Set printer-specific settings in the printer
Download fonts and macros to your printer

The Remote Control Panel can be used with all Windows operating systems with a 
non-networked printer when connected with either the parallel or USB interface. 

Installing the Remote Control Panel
The Remote Control Panel utility can be installed from the Software and Documentation 
CD-ROM or at www.xerox.com/office/3500support.

Feature Windows 2000, Windows 
XP, Windows Server 2003

Windows 
NT4.0

Windows 9x
Windows Me

Mac OS
9.x

Mac OS X, 
version

10.2~10.3

Print-Quality 
Modes

Both Both Both PostScript PostScript

2-Sided 
Printing1

1 Must have an optional duplex unit (Phaser 3500B and Phaser 3500N configurations).

Both Both Both PostScript PostScript

N-Up Both Both Both PostScript PostScript

Booklet1 Both PCL6 PCL6 — —

Poster 
Printing

PCL6 PCL6 PCL6 — —

Fit to Page Both Both Both PostScript PostScript

Mirrored 
Output

PostScript PostScript PostScript PostScript —

Negative 
Output

PostScript PostScript PostScript PostScript —

Scaling Both Both Both PostScript PostScript

Watermarks PCL6 PCL6 PCL6 — —

Cover Page2

2 Availability varies depending on your Macintosh OS version. Mac OS 10.3 version supports the 
Cover Page feature by default.

PCL6 PCL6 PCL6 PostScript PostScript

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Changing Settings with the Remote Control Panel
To change settings using the Remote Control Panel:

1. Click Start, select Programs, select Xerox Phaser 3500, then click Remote Control 
Panel.

2. Make changes to the Remote Control Panel settings on the Printing, Config, Job, Test 
PCL, Flash Font and Macro, and PS 3 tabs.

Note
Use the help features by referring the windows which appears when you click the 
Help button at the bottom.

3. Send the settings to the printer by clicking the Send button.

Note
Settings selected in the printer driver override settings selected in the Remote Control 
Panel.

Managing Your Printer
There are a number of resources available to help you get the best quality printing from your 
printer.

Printer’s IP Address
You need your printer’s IP address to change printer settings through CentreWare IS. Follow 
these steps to identify your printer’s IP address:

1. On the control panel, press the Menu button, then press the OK button to select 
Information.

2. Select Printer Ident, then press the OK button.

3. Select IP Address, then press the OK button.

CentreWare Internet Services (IS)
CentreWare IS is a printer management tool that helps users and administrators accomplish 
many tasks. It is available on all networked printers. With CentreWare IS you can:

Access remote diagnostics and troubleshooting information for printer problems.
Monitor printer and supply status.
Link to software updates and technical support.

CentreWare IS uses TCP/IP (your printer’s IP address) to communicate directly with an 
embedded web server on the printer. CentreWare IS runs on any TCP/IP-enabled computer 
with a web browser.
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Launching CentreWare IS
To launch CentreWare IS:

1. Launch your web browser.

2. Enter your printer's IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx). 

3. For detailed information about CentreWare IS software, click HELP on the upper right of 
the CentreWare IS screen.

Status Monitor
Status Monitor is installed when you select Install Status Monitor while installing the printer 
software, and available only with Windows on a network-enabled or a USB cable-connected 
printer. It automatically checks the printer status and sends instant notifications to your 
computer if the printer needs attention.

Whenever the printer is unable to print a document, the printer automatically sends a message 
that indicates an error and provides the corresponding solution. Using Status Monitor, you can 
also access the HTML Troubleshooting Guide, which provides an animated message showing 
how to address the problem. You do this by double-clicking task bar or from the Windows 
Start menu.

Printer Settings

Accessing Power Saver
To save energy, the printer enters a low-energy consumption mode after a predefined period of 
time has elapsed since its last activity. In this mode, called Power Saver, most printer electrical 
systems are shut down. When a print job is sent to the printer, the printer enters Warmup mode. 
You can also warm up the printer by pressing the OK button on the control panel.

If you find that the printer is going into the Power Saver mode too often and you do not want 
to wait while the printer warms up, you can increase the length of time before the printer goes 
into the Power Saver mode. Change the timeout value as follows:

1. On the control panel, press the Menu button, select Printer Setup, then press 
the OK button.

2. Select General Setup, then press the OK button.

3. Select Power Saver, then press the OK button.

4. Press the Down Arrow or Up Arrow button to scroll to a selected Power Saver timeout 
value. Select a larger value if you want to extend the length of time before the printer goes 
into Power Saver mode.

5. Press the OK button.
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Selecting Tray Settings

Tray Selection
You can select the tray to be used.

1. On the control panel, press the Menu button, select Printer Setup, then press 
the OK button.

2. Press the OK button to select Paper Handling.

3. Press the OK button to select Paper Source.

4. Scroll to the desired tray or Auto Select.
5. Press the OK button to save the changes.

Tray Sequence
You can specify the sequence in which the printer selects the paper trays. When a tray runs out 
of a particular paper during printing, the printer selects the next tray in the sequence containing 
the same paper type and size to continue printing.

To specify the tray sequence on the control panel:

1. Press the Menu button, select Printer Setup, then press the OK button.

2. Press the OK button to select Paper Handling.

3. Select Tray Sequence, then press the OK button.

4. Scroll to the desired tray sequence.

5. Press the OK button to save the changes.

Changing Printer Language
To change the language used for the text on the control panel, CentreWare IS, and some 
information pages:

1. On the control panel, press the Menu button, select Printer Setup, then press 
the OK button.

2. Select General Setup, then press the OK button.

3. Select FP Language, then press the OK button. 

4. Select the desired language, then press the OK button.
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Fonts
Your printer uses the following types of fonts:

Resident fonts
Fonts downloaded into printer memory
Fonts downloaded with your print job from the application
Fonts downloaded into printer flash memory

Resident PostScript Fonts
Printer-resident fonts are always available for printing. All printers are shipped with PostScript 
resident Roman fonts. You can print a sample of the resident PostScript fonts from the control 
panel.

Resident PCL Fonts
For PCL printing, the printer includes many typefaces, including Courier, Times, and Universe 
typefaces in medium, bold, italic medium, and italic bold. You can print a sample of resident 
PCL fonts from the control panel.

Printing a List of Available Fonts
To print a list of available PostScript or PCL fonts, use:

The control panel
The printer driver

Using the Control Panel
To print either a PostScript or PCL font list on the control panel:

1. Press the Menu button, then press the OK button to select Information.

2. Select Info Pages, then press the OK button.

3. Select either PCL Font List or PS Font List, then press the OK button to print.

Using a PC Printer Driver
You can print a font list from the printer driver. PostScript font lists are available only with 
Windows 2000, Windows XP, or Windows Server 2003.

To print either a PostScript or PCL font list from your printer driver:

1. Select Start.

2. Select one of the following options:

For Windows 98/Me/NT4.0/2000, select Settings and then Printers.
For Windows XP/Server 2003, select Printers and Faxes.
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3. Right-click the icon for your printer and select Printing Preferences.

4. Select the Troubleshooting tab.

5. Click the drop-down arrow in the Printer Information Pages field to view the list of 
options.

6. Select PCL Font List or PostScript Font List from the drop-down list.

7. Click Print.

Registering Your Printer
Registering your printer is quick and easy. You can register your printer using one of the 
following methods:

Mail the registration card that came with your printer
Fill out the online form at www.xerox.com/office/register

Registering your printer provides you with updates and news about your printer.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Reg&Language=english
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Printing
Supported Paper
Follow the guidelines in these tables to ensure the best print quality and avoid printer jams. For 
best results, use only Xerox Printing Media specified for your printer. These media are 
guaranteed to produce excellent results with your Phaser 3500 Laser Printer.

Note
Print transparencies only from Tray 1 (MPT). Print letterhead only from Tray 1 (MPT) and 
Tray 2. For best results, Xerox highly recommends that you print other specialty media 
from Tray 1 (MPT).

Supported Paper, Transparencies, and Other Specialty Media

■ User-Selected Size

● Auto-Sensed Size

▲ Supported

Tray 1 (MPT) Weight: 60~176 g/m2 (16~65 lb. Cover)

Tray 2 and 3 Weight: 60~105 g/m2 (16~28 lb.)

Duplex Weight: 75~90 g/m2 (20~24 lb.)

Tr
ay

 1
 (

M
P

T
) 

Tr
ay

 2
 

Tr
ay

 3
1

1 Optional

2-
S

id
ed

 P
ri

n
ti

n
g

2  

2 Option for the Phaser 3500B and Phaser 3500N configurations

Paper Type/Size Dimensions

Letter 8.5 in. x 11 in. ■ ● ● ▲

Legal 8.5 in. x 14 in. ■ ● ● ▲

US Folio 8.5 in. x 13 in. ■ ● ● ▲

A4 210 mm x 297 mm ■ ● ● ▲

B5-JIS 182 mm x 257 mm ■ ● ●

ISO-B5 176 mm x 250 mm ■ ● ●

A5 148 mm x 210 mm ■ ● ●

Executive 7.25 in. x 10.5 in. ■ ● ●

Statement 5.5 in. x 8.5 in. ■

US Postcard 3.5 in. x 5.5 in. ■

Index Card 3 in. x 5 in. ■

A6 Postcard 105 mm x 148 mm ■

Envelopes

Monarch

#10 Commercial

C5

C6

DL

3.88 in. x 7.5 in.

4.13 in. x 9.5 in.

162 mm x 229 mm

114 mm x 162 mm

110 mm x 220 mm 

■

■

■

■

■

Transparencies

Letter

A4

8.5 in. x 11 in.

210 mm x 297 mm
■

■

Labels

Letter

A4

8.5 in. x 11 in.

210 mm x 297 mm

■

■

Custom Width = 76 mm~216 mm (3 in.~8.5 in.); 

Length = 127 mm~356 mm (5 in.~14 in.)

■
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Basic Printing
For information about how to load paper in Tray 1 (MPT), Tray 2, or Tray 3, see the Quick 
Reference Guide that came with your printer. The Quick Reference Guide can also be found at 
www.xerox.com/office/3500support.

Note
A minimum clearance of 32 cm (12.6 in.) must be maintained at the rear of the printer. See 
the Setup Guide that came with your printer for minimum clearances.

Changing Paper Type and Size on the Control Panel
If you have changed the paper size in Tray 1 (MPT), you need to change the printer settings. 
You can change the paper size on the control panel when you load paper in Tray 1 (MPT). If 
you load paper in Tray 2 or Tray 3, your printer automatically senses the paper size loaded. To 
change the paper size, on the control panel:

1. Press the Menu button, select Printer Setup, then press the OK button.

2. Press the OK button to select Paper Handling.

3. Select Tray 1 Size, then press the OK button.

4. Scroll to the paper size loaded in Tray 1, then press the OK button.

5. Press the Cancel button to return to the main menu.

If you have changed the paper type, you need to change the printer settings. On the control 
panel:

1. Press the Menu button, select Printer Setup, then press the OK button.

2. Press the OK button to select Paper Handling.

3. Select Tray [1, 2, or 3] Type, then press the OK button.

4. Scroll to the paper type loaded, then press the OK button.

5. Press the Cancel button to return to the main menu.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Adjusting Printing Options

Setting Printing Options
Many printing options are available with the Xerox printer driver. 

Selecting Printing Preferences in Windows
Printing preferences control all of your jobs, unless you overwrite them specifically for a 
particular job. For example, if you want to use N-up printing for most jobs, set this option in 
printer settings.

1. Click Start.

2. Select one of the following options:

For Windows 98/Me/NT4.0/2000, select Settings and then Printers.
For Windows XP/Server 2003, select Printers and Faxes.

3. Right-click the icon for your printer and:

In Windows 98/Me, select Properties.
In Windows 2000/XP/Server 2003, select Printing Preferences.
In Windows NT4.0, select Document Defaults.

4. Make selections from the driver tabs. See the “PCL6 Printer Driver Options for Windows 
Operating Systems” table or “PostScript Printer Driver Options for Windows Operating 
Systems” table for specific printing options.

5. Click the OK button to save your selections.

Selecting Properties for an Individual Job
If you want to use special settings for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use the 1200 dpi Image Quality 
mode for a particular graphic, select this setting in the driver before printing that job.

1. With the desired document or graphic open in your application, access the Print dialog 
box.

2. Select the Phaser 3500 printer and click the Properties or Preferences button to open the 
printer driver.

3. Make selections from the driver tabs. See the “PCL6 Printer Driver Options for Windows 
Operating Systems” table or “PostScript Printer Driver Options for Windows Operating 
Systems” table for specific printing options.

4. Click the OK button to save your selections.

5. Print the job.
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Note
For more information about printing options and other features, click the Help button on 
each printer tab to view online help.

PCL6 Printer Driver Options for Windows Operating Systems

Operating System Driver Tab Printing Options

Windows 2000, 
Windows XP, 
Windows NT4.0, or 
Windows Server 
2003

Layout tab Orientation

2-Sided Printing1

1 The Phaser 3500B and Phaser 3500N configurations may be upgraded to use these printing 
options. Install an optional duplex unit.

More Layout Options 
dialog box

Multiple Pages per Side

Poster

Booklet Printing1 

Fit to Page

Reduce/Enlarge

Paper tab Print Quantity

Size

Custom

Type

Source

Cover Page

Image Options tab Print-Quality Mode

TrueType Options

Print All Text Black

Output Options tab Print Order

Use Printer Fonts

Collate

Watermark tab Current Watermarks

Watermark Message

Message Angle

Font Attributes

Troubleshooting tab Print Information Pages

Web Links
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PostScript Printer Driver Options for Windows Operating Systems

Operating System PostScript Driver Tab Printing Options

Windows 2000, 
Windows XP, or 
Windows Server 2003

Layout tab Orientation

Print on Both Sides1

Page Order

Pages Per Sheet

Booklet1

Paper/Quality tab Paper Source

Advanced Options dialog 
box

Paper Size

Scaling

Mirrored Output

Negative Output

Fit to Page

Paper Type

Print Quality

Troubleshooting tab Printer Information Pages

Helpful Web Links

Windows NT4.0 Paper Setup tab Paper Size

Orientation

Paper Source

Printing on Both Sides (Duplex 

Printing)1

Advanced dialog box Resolution

Scaling

Mirrored Output

Negative Output

Image Quality

Fit to Page

Paper Type
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Note
If you are using Windows 2000, Windows XP, or Windows Server 2003 you can view online 
help about printing options and other features. Click the Help button on the Troubleshooting 
tab.

Using the Manual Feed Mode
Follow these steps to print a manual print job from Tray 1 (MPT):

1. At your computer, select Print, select Properties or Preferences, select the Paper tab, select 
the Force printing from specific tray, select Tray 1 [Manual Feed] from the Source 
drop-down list, then click OK to send the job to the printer.

2. Open Tray 1 (MPT) by pushing the handle down and pulling out. 

Windows 98 or 
Windows Me

Paper tab Paper Size

Layout

Orientation

Paper Source

Copies

More Paper Options dialog 
box

Printing on Both Sides (Duplex 

Printing)1

Graphics tab Resolution

Halftoning

Special

Scaling

Device Options tab Fit to Page

Paper Type

Print Quality

PostScript tab PostScript Output Format

1 The Phaser 3500B and Phaser 3500N configurations may be upgraded to use these printing 
options. Install an optional duplex unit.

PostScript Printer Driver Options for Windows Operating Systems (Continued)

Operating System PostScript Driver Tab Printing Options
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3. Slide the extender toward you until it locks into place.

4. Adjust the paper guides to match the size of the paper, transparency, or other specialty 
media.

5. When prompted at the control panel, insert paper, transparency, or other specialty media 
into the tray. Place the side to be printed face up with the top of the page entering the 
printer first.

6. If necessary, press the guides inward to match the size of the paper.

Tray 1 (MPT) detects the paper and prints the page.

Selecting the Bypass Tray 1 (MPT) Mode
The Bypass Tray 1 (MPT) mode setting can be set from the control panel. There are two 
options:

When the bypass mode is enabled (On), the printer prints the job on the paper loaded in 
Tray 1 (MPT) even if it does not match the paper type and size selected for the print job. To 
use a tray other than Tray 1 (MPT), you must select Force printing from a specific tray in 
your printer driver.
When the bypass mode is disabled (Off), the printer prints from the tray containing the 
requested paper type and size for the print job.
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Using the Control Panel
To enable or disable the Bypass Tray 1 (MPT) mode on the control panel:

1. Press the Menu button, select Printer Setup, then press the OK button.

2. Press the OK button to select Paper Handling.

3. Press the Up Arrow or Down Arrow button to select Bypass Tray 1 (MPT), then press 
the OK button.

4. Press the Up Arrow or Down Arrow button to select On or Off, then press 
the OK button.

2-Sided Printing

Automatic 2-Sided Printing

Guidelines
A duplex unit must be installed on your printer to perform automatic 2-sided printing. The 
Phaser 3500B and Phaser 3500N configurations may be upgraded to include this feature.
Use only letter, legal, A4, or US Folio with dimensions and weights listed for automatic 
2-sided printing in “Supported Paper” on page 12.
Use paper with a weight range between 75~90 g/m2 (20~24 lb.).

Binding Preferences
Use the printer driver to select Portrait or Landscape orientation for the images on the page. 
When you print 2-sided jobs, you need to select the binding preference. This determines how 
the pages turn.

Portrait
Flip on Long Edge

Portrait
Flip on Short Edge

Landscape
Flip on Short Edge

Landscape
Flip on Long Edge
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Checking Duplex Unit Status in Printer Properties (Phaser 3500B and Phaser 3500N configurations 

only)

For the Phaser 3500B and Phaser 3500N configurations, before printing two-sided jobs, make 
sure that the optional duplex unit is set as installed in the Windows printer properties window. 
The procedure differs depending on the printer driver used.

If you use the Windows PostScript driver:

1. Click Start.

2. Select one of the following options:

For Windows 98/Me/NT4.0/2000, select Settings and then Printers.
For Windows XP/Server 2003, select Printers and Faxes.

3. Right-click on the icon for your printer and select Properties.

4. Select one of the following options:

For Windows 98/Me, select the Device Options tab, select Duplex Unit in the 
Installable Options section, and select Installed in the Change Setting for section.
For Windows 2000/XP/Server 2003, select the Device Settings tab and set Duplex 
Unit in the Installable Options section to Installed.
For Windows NT4.0, select the Device Settings tab, select Duplex Unit in the 
Installable Options section, and select Installed in the Change ‘Duplex Unit’ 
Setting section.

5. Click OK to save your choice.

If you use the Windows PCL6 driver:

1. Click Start.

2. Select one of the following options:

For Windows 98/Me/NT4.0/2000, select Settings and then Printers.
For Windows XP/Server 2003, select Printers and Faxes.

3. Right-click on the icon for your printer and select Properties.

4. Select the Printer Configuration tab and select the Optional Duplex Unit Installed 
checkbox.

5. Click OK to save your choice.

Printing 2-Sided Jobs
To print on both sides of the sheet in a supported driver:

Windows 98 or Windows Me PostScript driver:

1. Insert paper into the tray. For information, see the Quick Reference Guide that came with 
your printer. The Quick Reference Guide can also be found at www.xerox.com/office/
3500support.

2. In the printer driver, on the Paper tab, click the More Options button, then select None, 
Flip on Long Edge, or Flip on Short Edge under Printing on Both Sides (Duplex 
Printing).

3. Click OK to accept the printer driver settings, then click OK to print.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Windows 2000, Windows XP, or Windows Server 2003 PostScript driver:

1. Insert paper into the tray. For information, see the Quick Reference Guide that came with 
your printer. The Quick Reference Guide can also be found at www.xerox.com/office/
3500support.

2. In the printer driver, on the Layout tab, select None, Flip on Long Edge, or Flip on 
Short Edge under Print on Both Sides.

3. Click OK to accept the printer driver settings, then click OK to print.

Windows NT4.0 PostScript driver:

1. Insert paper into the tray. For information, see the Quick Reference Guide that came with 
your printer. The Quick Reference Guide can also be found at www.xerox.com/office/
3500support.

2. In the printer driver, on the Page Setup tab, select None, Long Side, or Short Side under 
Printing on Both Sides (Duplex Printing).

3. Click OK to accept the printer driver settings, then click OK to print.

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

1. Insert paper into the tray. For information, see the Quick Reference Guide that came with 
your printer. The Quick Reference Guide can also be found at www.xerox.com/office/
3500support.

2. In the printer driver, on the Layout tab, select None, Long Edge, or Short Edge under 
2-Sided Printing.

3. Click OK to accept the printer driver settings, then click OK to print.

Mac OS 9.x PostScript driver:

1. Insert paper into the tray. For information about how to load paper, see the Quick 
Reference Guide.

2. Go to Orientation in Page Setup and select Portrait, Landscape, or Rotated 
Landscape. 

3. Click OK to save your settings.

4. In the printer driver:

a. In the Print Options dialog box, click the pull-down menu, and then select Layout.
b. Select Double-sided Printing, and then a binding orientation from the Binding 

option.

5. Click OK to accept the Print Options settings, then click Print to print your job.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Mac OS X, version 10.2~10.3 PostScript driver:

1. Insert paper into the tray. For information about how to load paper, see the Quick 
Reference Guide.

2. Go to Orientation in Page Setup and select Portrait, Landscape, or Rotated 
Landscape. 

3. Click OK to save your settings.

4. In the printer driver:

For Mac OS X, version 10.2

a. Click on the left pull-down menu and select Duplex. 
b. Select the Print on Both Sides checkbox, then select a binding orientation from the 

Binding option. 

For Mac OS X, version 10.3

a. Click on the left pull-down menu and select Layout.
b. Select Long Edge Binding or Short Edge Binding from the Two Sided Printing 

option.

5. Click Print to print your job.

Manual 2-Sided Printing
Manual 2-sided printing is supported for paper with dimensions and weights listed in 
“Supported Paper” on page 12. Print manual 2-sided jobs from Tray 2 or Tray 3. 

1. Load paper into Tray 2 or Tray 3. 

2. At your computer, select even numbered pages from the Output Options driver tab. Set 
the paper type and size according to the steps listed in “Changing Paper Type and Size on 
the Control Panel” on page 13. 

3. Select Force printing from specific tray and Tray 2 [or 3] as the paper source, and then 
click Print to print one side of your job.

4. Remove the pages from the output tray and place the printed side face up in Tray 2 [or 3] 
with the top of the page entering the printer last.

5. At your computer, select odd numbered pages to print.

6. Click Print to print the other side of your print job.
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Transparencies
Print transparencies from Tray 1 (MPT) only.

Guidelines
Place no more than 50 transparencies at one time in Tray 1 (MPT).

Handle transparencies by the edges, using both hands to avoid fingerprints and creases 
which can cause poor print quality.
Use transparencies intended for monochrome laser printers.

Printing Transparencies from Tray 1 (MPT)
1. Fan the transparencies to release sheets that may stick together.

2. Insert the transparencies into Tray 1 (MPT). For information about how to load paper in 
Tray 1 (MPT), see the Quick Reference Guide that came with your printer. The Quick 
Reference Guide can also be found at www.xerox.com/office/3500support.

3. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Size, then press the OK button.
d. Select Letter or A4, then press the OK button.
e. Press the Cancel button to return to the main menu.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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4. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Type, then press the OK button.
d. Select Transparency, then press the OK button.
e. Press the Cancel button to return to the main menu.

5. In the printer driver, select Tray 1 as the paper source.
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Envelopes

Guidelines

Buying and Storing Envelopes
Use only paper envelopes specified in “Supported Paper” on page 12. Successful envelope 
printing is highly dependent on the quality and construction of the envelopes. Use 
envelopes made specifically for laser printers.
It is recommended that you maintain constant temperatures and relative humidity in your 
printer room.
Store unused envelopes in their packaging to avoid the effects of moisture and dryness 
which can affect print quality and cause wrinkling. Excessive moisture can cause the 
envelopes to seal before or during printing.
Avoid padded envelopes; purchase envelopes that lie flat on a surface. 
Remove air bubbles from the envelopes before loading them in the tray by setting a heavy 
book on top of the envelopes.

Preparing to Print
Follow these guidelines to prevent wrinkling problems:

Use only Tray 1 (MPT) to print envelopes.
Print only on the front of the envelope.
Perform these steps when using an application that includes a tool for creating an envelope 
document:

Select faceup.
Select the feed method with the image centered.
Clear Clockwise Rotation.
Load a maximum of 10 envelopes at a time. This printer is not designed to handle 
high-capacity production envelope printing.

Caution
Never use envelopes with windows or metal clasps; they can damage the printer. Damage 
caused by using unsupported envelopes is not covered under the Xerox warranty, service 
agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available 
in the United States and Canada. Coverage may vary outside these areas, please contact 
your local representative for details.
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Printing Envelopes

Note
Some wrinkling or embossing may occur when printing envelopes.

1. Insert the envelopes face up with the top of the envelope to the left as you view the front 
of the tray. Adjust the guides to match the size of the envelopes. Maximum capacity is 10 
envelopes.

2. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Size, then press the OK button.
d. Select the envelope size, then press the OK button.
e. Press the Cancel button to return to the main menu.

3. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Type, then press the OK button.
d. Select Envelope, then press the OK button.
e. Press the Cancel button to return to the main menu.

4. In the printer driver, select Tray 1 as the paper source.

5. Print a test envelope from your application to confirm that the orientation of your envelope 
is correct.

For information, see the Quick Reference Guide that came with your printer. The Quick 
Reference Guide can also be found at www.xerox.com/office/3500support.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Labels
Labels can be printed only from Tray 1 (MPT). The maximum number of sheets that can be 
loaded in Tray 1 (MPT) is 25. 

Guidelines
Use only labels recommended for laser printers.
Do not use vinyl labels.
Verify that the labels’ adhesive material can tolerate fusing temperatures of 200° C 
(392° F) for 0.1 second.
Do not use any sheets where labels are missing; it may damage printer components.
Store unused labels flat in their original packaging. Leave the labels inside the original 
packaging until ready to use. Return any unused labels to the original packaging and reseal 
it for protection.
Do not store labels in extremely dry or humid conditions or extremely hot or cold 
conditions. Storing them in extreme conditions may cause print quality problems or cause 
them to jam in the printer. 
Rotate stock frequently. Long periods of storage in extreme conditions can cause the 
labels to curl and jam the printer.
Print only on one side of the sheet of labels.

Printing Labels
If your application has a setting for labels, use it as a template. 

1. Insert the labels into Tray 1 (MPT). Place the labels face up with the top of the sheet 
entering the printer first. Adjust the guides to match the size of the sheet. 

2. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Size, then press the OK button.
d. Select Letter or A4, then press the OK button.
e. Press the Cancel button to return to the main menu.



Custom Size Paper

Phaser® 3500 Laser Printer
28

3. On the printer’s control panel:

a. Press the Menu button, select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Type, then press the OK button.
d. Select Labels, then press the OK button.
e. Press the Cancel button to return to the main menu.

4. In the printer driver, select Tray 1 as the paper source.

Custom Size Paper
Print custom size paper or specialty media in Tray 1 (MPT).

You can print on custom size paper within these dimensions:

Loading Custom Size Paper in Tray 1 (MPT)
1. Insert the custom size paper into Tray 1 (MPT). Adjust the guides to match the size of the 

paper. Place the side to be printed face up with the top of the page entering the printer 
first.

2. On the printer’s control panel:

a. Press the Menu button, then select Printer Setup, then press the OK button.
b. Press the OK button to select Paper Handling.
c. Select Tray 1 Size, then press the OK button.
d. Select Custom, then press the OK button.

1-sided Manual 2-sided
Width = 76.2~215.9 mm (3~8.5 in.) 

Length = 127~355.6 mm (5~14 in.)

Width = 76.2~215.9 mm (3~8.5 in.) 

Length = 127~355.6 mm (5~14 in.)
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e. Select Custom X, then press the OK button.

f. Press the Down Arrow or Up Arrow button to set the paper size, then press 
the OK button.

g. Select Custom Y, then press the OK button.
h. Press the Down Arrow or Up Arrow button to set the paper size, then press 

the OK button.
i. Press the Cancel button to return to the main menu.

3. In the printer driver, select Tray 1 as the paper source.

Advanced Options

Printing Multiple Pages to a Single Sheet (N-Up)
When printing a multiple-page document, you can print more than one page on one side of a 
single sheet of paper. Print one, two, four, six, nine, or 16 pages per side.

To print multiple pages on a single sheet of paper in a supported driver:

Windows 98 or Windows Me PostScript driver:

On the Paper tab, select the number of pages per sheet under Layout, and click OK to 
save your choice.

Windows 2000, Windows XP, or Windows Server 2003 PostScript driver:

On the Layout tab, select the number of pages per sheet from the Pages Per Sheet 
drop-down list, and click OK to save your choice. 

X

Y



Advanced Options

Phaser® 3500 Laser Printer
30

Windows NT4.0 PostScript driver:

On the Page Setup tab, click the Advanced button and select the number of pages per 
sheet from the Page Layout (N-up) Option drop-down list in the Document Options 
section. Click OK to save your choices.

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

On the Layout tab, click the More Layout Options button, select Multiple Pages per 
Side, and select the number of pages per sheet from the Pages per Side drop-down list. If 
necessary, select the page order from the Page Order drop-down list, and/or check Print 
Page Border to print a border around each page on the sheet. Click OK to save your 
choices.

Note
Page Order and Print Page Border are enabled only when the number of pages per 
sheet is 2, 4, 6, 9, or 16.

Mac OS 9.x PostScript driver:

In the printer driver, click the pull-down menu for General and select the number of pages 
per sheet.

Mac OS X, version 10.2 and higher PostScript driver:

In the printer driver, click on the pull-down menu and select Layout. Select the number of 
pages per sheet from the Pages per Sheet pull-down list. Select the type of border desired 
for each page on the sheet from the Border pull-down list.

Scaling
You can reduce or enlarge your page images when they are printed by selecting a scaling 
value. The default is 100 percent. 

To select scaling in a supported driver:

Windows 98 or Windows Me PostScript driver:

On the Graphics tab, select a percentage between 25 and 400 for your print job from the 
Scaling input box, and click OK to save your choices.

50% 100% 200%
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Windows 2000, Windows XP, or Windows Server 2003 PostScript driver:

On the Layout tab, click the Advanced button and select a percentage between 1 and 
1000 for your print job from the Scaling input box in the Graphic section. Click OK to 
save your choices.

Windows NT4.0 PostScript driver:

On the Page Setup tab, click the Advanced button and select a percentage between 1 and 
1000 for your print job from the Scaling input box in the Graphics section. Click OK to 
save your choices.

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

Fit to Page:

On the Layout tab, click the More Layout Options button, select Fit to Page, then set the 
correct size from the Target Page drop-down list. Click OK to save your choices.

Reduce/Enlarge:

On the Layout tab, click the More Layout Options button, select Reduce/Enlarge, then 
specify a percentage between 25 and 400 for your print job from the Percentage input 
box. Click OK to save your choices. 

Mac OS 9.x or Mac OS X, version 10.2 and higher PostScript driver:

In Page Setup, specify a percentage for your print job in Scale.

Printing Booklets
With two-sided printing, you can print a document in the form of a small book. Create 
booklets with any paper size that is supported for 2-sided (duplex) printing. For more 
information on paper types, weights, and sizes, see “Supported Paper” on page 12.

Note
A duplex unit must be installed on your printer to perform automatic 2-sided printing. The 
Phaser 3500B and Phaser 3500N configurations may be upgraded to include this feature. 
Make sure that the installed duplex unit is set in the Windows printer properties window. 
For details, see page 20.

To print booklets in a supported driver:

Windows 2000, Windows XP, or Windows Server 2003 PostScript driver:

On the Layout tab, select Portrait or Landscape under Orientation, select Flip on Long 
Edge or Flip on Short Edge under Print on Both Sides, select Front to Back under 
Page Order, and select Booklet from the Pages Per Sheet drop-down list. Click OK to 
save your choices. 

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

On the Layout tab, click the More Layout Options button, and select Booklet Printing. 
Click OK to save your choice.
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Printing Posters
Poster printing allows you to print large, multiple-sheet versions of your page.

To print posters in a supported driver:

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

On the Layout tab, click the More Layout Options button, select Poster and set the Page 
Layout and Overlap values. If you select Custom from the Page Layout drop-down list, 
set the desired scale rate in the Scale Factor input box. Click OK to save your choices. 

Printing Negative and Mirror Images
You can print a page as a negative image (reverses the light and dark areas in your printed 
image) or a mirror image (flips images horizontally on pages when printed).

To print negative images or mirror images in a supported driver:

Windows 98 or Windows Me PostScript driver:

On the Graphics tab, select the Print as a Negative Image checkbox or the Print as a 
Mirror Image checkbox under Special and click OK to save your choice.

Windows 2000, Windows XP, or Windows Server 2003 PostScript driver:

On the Layout tab, click the Advanced button, select PostScript Options in the 
Document Options section, and select Yes or No for the Mirrored Output drop-down 
list or the Negative Output drop-down list. Click OK to save your choice.

Windows NT4.0 PostScript driver:

On the Page Setup tab, click the Advanced button, select Postscript Options in the 
Document Options section, and select Yes or No for the Mirrored Output drop-down 
list or the Negative Output drop-down list. Click OK to save your choice.

Mac OS 9.x PostScript driver:
In Page Setup, click Options. 
In the PSPrinter Options dialog box, under Visual Effects, select Flip Horizontal, 
Flip Vertical, or Invert Image.

Negative Image Mirror Image
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Printing Watermarks
A watermark is additional text that can be printed across one or more pages. For example, terms 
like Draft, Confidential, Date, or Version that you might stamp on a page before distribution, 
can be inserted as a watermark.

In some Windows drivers you can:

Create a watermark
Edit an existing watermark’s text, color, location, and angle
Place a watermark on either the first page or every page of a document
Print the watermark in the background
Print the text of the watermark as an outline (instead of filled text)

Note
Not all applications support watermark printing.

To select, create, and edit watermarks using a supported Windows driver:

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

In the printer driver, select the Watermark tab to display the Watermark properties 
window.

Printing Cover Pages
A cover page can be printed as the first page of a document. The printer enables you to choose a 
different paper source for the cover page than for the body of a document. For instance, use 
your company letterhead or colored paper for the first page of a document or report.

Guidelines
Use any paper tray, within the weight ranges listed in “Supported Paper” on page 12, as the 
source for printing cover pages.
Verify that the cover page is the same size as the paper used for the rest of your document. 
If you specify a different size in the driver than the tray you select as a cover page source, 
your cover prints on the same paper as the rest of your document.
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Printing Cover Pages
To print cover pages in a supported driver:

Windows 98 SE, Windows Me, Windows 2000, Windows XP, Windows NT4.0, or 
Windows Server 2003 PCL6 driver:

On the Paper tab, select the desired tray to use for the cover from the Cover Page 
drop-down list, then click OK to save your choice.

Mac OS 9.x PostScript driver:
a. Click Options. 
b. In the Print Options dialog box, under Cover Page, select None, Before, or After 

Document, then click OK to save your choice. 
c. Under Paper Source, click the pull-down menu and select the desired tray to use for 

the cover.
Mac OS X, version 10.3 PostScript driver: 
a. In the printer driver, click the pull-down menu and select Cover Page.
b. In Printer Cover Page, select None, Before Document, or After Document.
c. In Cover Page Type, click the pull-down menu and make a selection.
d. If necessary, enter additional information in Billing Info to be printed on the cover 

page.

Supplies and Recycling

Supplies
The printer’s control panel displays status messages and warnings as the print cartridge nears 
its replacement time. When the control panel prompts that the toner is low or needs to be 
replaced, verify that you have replacements on hand.

To order supplies, contact your local reseller or go to www.xerox.com/office/3500supplies.

Configuration Page
The “Configuration Page” displays the status of the toner in the print cartridge. To print the 
“Configuration Page”:

1. On the control panel, press the Menu button, then press the OK button to select 
Information. 

2. Select Info Pages, then press the OK button. 

3. Select Config Page, then press the OK button to print the page. 

Recycling
For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.

http://www.xerox.com/gwa
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Order&Language=english
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Connections and Networks
Overview of Network Setup and Configuration
To set up and configure the network:

1. Turn on the printer and the computer.

2. Connect the printer to the network using the recommended hardware and cables.

3. Configure the printer’s network address, which is required to identify the printer on the 
network. 

Windows operating systems: Run the Installer on the Software and Documentation 
CD-ROM to automatically set the printer’s IP address if the printer is connected to an 
established TCP/IP network. You can also manually set the printer’s IP address on the 
control panel.
Macintosh systems: Manually set the printer’s network address (for TCP/IP) on the 
control panel.

4. Install the driver software on the computer from the Software and Documentation 
CD-ROM. For information on driver installation, see the section in this chapter for the 
specific operating system you are using.

Note
If the Software and Documentation CD-ROM is not available, you can download the latest 
driver at www.xerox.com/office/drivers.

Choosing a Connection Method
Connect the printer to the network via Ethernet or USB. Hardware and cabling requirements 
vary for the different connection methods. Cabling and hardware are generally not included 
with your printer and must be purchased separately.

Connecting via Ethernet
Ethernet can be used for one or more computers. It supports many printers and systems on an 
Ethernet network. It also allows you direct access to CentreWare Internet Services (IS). 
CentreWare IS provides a simple interface that enables you to manage, configure, and monitor 
networked printers from your desktop using an embedded web server. For complete 
information about CentreWare IS, click the Help button in CentreWare IS to go to the 
CentreWare IS Online Help.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=driver&Language=english
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Network Connection
Depending on your particular setup, the following hardware and cabling is required for 
Ethernet.

If you are connecting to one computer, an Ethernet RJ-45 crossover cable is required. 
If you are connecting to one or more computers with a hub, an Ethernet hub and two 
twisted-pair (category 5/RJ-45) cables are required. 
If you are connecting to one or more computers using a cable or DSL router, a cable or 
DSL router and two or more twisted-pair (category 5/RJ-45) cables are required. (One 
cable for each device.)
If you are connecting to one or more computers with a hub, connect the computer to the 
hub with one cable, and then connect the printer to the hub with the second cable. Connect 
to any port on the hub except the uplink port.

TCP/IP and EtherTalk are the most common protocols used with Ethernet. To print using a 
TCP/IP protocol, each computer and printer requires a unique IP address. 

Standalone (Cable or DSL) Network Connection
For information about setting up a cable or DSL connection for your printer, go to the 
Knowledge Base at www.xerox.com/office/3500support.

Connecting via USB
If you are connecting to one computer, a USB connection offers fast data speeds. However, a 
USB connection is not as fast as an Ethernet connection. To use USB, PC users must have 
Microsoft Windows 98 SE, Windows Me, Windows XP, or Windows 2000. Macintosh users 
must use Mac OS 9.x and higher. 

USB Connection
A USB connection requires a standard A/B USB cable. This cable is not included with your 
printer and must be purchased separately. Verify that you are using the correct USB cable for 
your connection.

1. Connect one end of the USB cable to the printer and turn it on.

2. Connect the other end of the USB cable to the computer.

Connecting via Parallel Cable
A parallel cable connection can also be used for connecting to one computer. This type of 
connection provides the slowest data speeds. Parallel connection requires a standard-to-high 
density parallel printer cable, (36-pin high-density 1284-C [male] to 36-pin low density 
1284-B [male] cable), with a maximum length of 10 feet (three meters). Connect the parallel 
cable to the printer and the computer while they are both Off, and then turn them On. Install 
the printer driver from the Software and Documentation CD-ROM, and then select the 
appropriate LPT parallel port.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Configuring the Network Address

TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate 
TCP/IP addresses and additional configuration information. 

If you are creating your own small Local Area Network or connecting the printer directly to 
your computer using Ethernet, follow the procedure for automatically setting the printer’s 
Internet Protocol (IP) address. 

PCs and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
With TCP/IP protocols, each printer and computer must have a unique IP address. It is 
important that the addresses are similar, but not the same; only the last digit needs to be 
different. For example, your printer can have the address 192.168.1.2 while your computer has 
the address 192.168.1.3. Another device can have the address 192.168.1.4.

Generally, Macintosh computers use either TCP/IP or the EtherTalk protocol to talk to a 
networked printer. For Mac OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, 
EtherTalk does not require printers or computers to have IP addresses.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically programs an IP address into every PC and printer on the network that is 
configured to use DHCP. A DHCP server is built into most cable and DSL routers. If you use a 
cable or DSL router, see your router’s documentation for information on IP addressing.

Automatically Setting the Printer’s IP Address
If the printer is connected to a small established TCP/IP network without a DHCP server, use 
the installer on the Software and Documentation CD-ROM to detect or assign an IP address to 
your printer. For further instructions, insert the Software and Documentation CD-ROM into 
your computer’s CD-ROM drive. After the Installer launches, follow the prompts for 
installation. 

Note
For the automatic Installer to function, the printer must be connected to an established 
TCP/IP network.
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Manually Setting the Printer’s IP Address

Note
Verify that your computer has a properly configured IP address for your network. Contact 
your network administrator for more information.

If you are on a network without a DNS server, or in an environment where the network 
administrator assigns printer IP addresses, you can use this method to manually set the IP 
address. Manually setting the IP address overrides DHCP and AutoIP. Alternatively, if you are 
in a small office with a single PC and use a dialup modem connection, you can manually set 
the IP address.

1. On the control panel, select Connection, and then press the OK button.

2. Select TCP/IP Setup, and then press the OK button.

3. Select DHCP/BOOTP, and then press the OK button.

4. Select Off, and then press the OK button.

5. Press the Return button to return to the TCP/IP Setup menu.

6. Select TCP/IP Setup, and then press the OK button.

7. Select IP Address, and then press the OK button.

8. Enter the printer’s IP address, and then press the OK button.

Installing the Printer Drivers

Windows 98 SE or Later and Windows 2000 or Later
To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the computer’s CD-ROM drive. If the installer does not launch, 
do the following:

a. Click Start, and then click Run.
b. In the Run window, type: <CD drive>:\SETUP.EXE.

2. Select your desired language from the list.

3. Select Install Printer Driver.

4. Select the installation method you want to use, and then follow the onscreen instructions.
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Macintosh OS 9.x
Create a desktop USB printer or use EtherTalk to install the printer driver.

USB
A USB-connected printer does not display in the Chooser. To create a desktop USB printer:

1. Insert the Software and Documentation CD-ROM into the CD-ROM drive.

2. Use the Desktop Printer Utility to create a desktop USB printer.

EtherTalk

Note
If you use EtherTalk, Macintosh computers do not require IP addresses. 

Follow these steps to install the printer driver:

1. Open the AppleTalk Control Panel.

2. Verify that the Ethernet port is the selected network port.

3. Double-click the installer on the Software and Documentation CD-ROM to install the 
printer driver.

4. Open the Chooser, and then click the LaserWriter driver.

5. From the right column of the Chooser, select the printer, and then click Create to create 
the desktop printer.

Macintosh OS X Version 10.2 and Higher
To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive. 

2. Open the Print Center utility. 

Note
In Macintosh OS X version 10.3 or higher, the utility is called Printer Setup Utility. 
To locate utilities on the Macintosh hard drive, open the Applications folder, and then 
open the Utilities folder. 

3. Click the Add icon in the Printer List window, and then select Rendezvous from the 
drop-down menu.

4. Select the printer in the window.

5. Select Xerox from the list of manufacturers in the lower drop-down menu.

6. Select the appropriate printer model from the list of available devices.

7. Click the Add button.
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Troubleshooting
Your printer is designed to produce consistently high-quality work. If you observe 
print-quality problems, use the information on these pages to troubleshoot the problem.

For detailed, online support information, go to www.xerox.com/office/3500support.

Print-Quality Problems
If you experience problems with print quality, go to www.xerox.com/office/3500support.

Cleaning the Outside of the Printer
You can clean the outside of the printer with a soft, damp cloth. You can use a cloth moistened 
with a mild neutral detergent to remove stains; do not spray detergent directly onto the printer.

Warning
To prevent electric shock, turn the printer off and unplug the power cord from the 
electrical outlet before cleaning the printer.

Do not use a vacuum cleaner to clean the printer. Do not lubricate the printer with oil.

Control Panel Messages
Your printer’s control panel provides you with information and troubleshooting help.

The control panel is divided into two sections. The upper section (1) displays printer menu and 
error messages; the lower section (2) contains the control panel control buttons.

1. Alphanumeric display

2. On-line/Data/Error LED

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
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Some of the LED descriptions and error messages that appear in the control panel are listed 
below.

LED Descriptions
The LED indicates the different functioning states of the printer: 

Errors and Warnings
The printer displays error or warning messages on the control panel display. 

Hardware or software failures that may require service support are presented as errors. When 
the printer’s control panel displays an error message, the LED blinks or turns orange. An error 
message replaces the status lines.

When an error occurs during printing, the Status Monitor balloon, available only with 
Windows on a network-enabled or a USB cable-connected printer, appears on your computer 
screen alerting you that the printer needs attention.

Moving and Repacking the Printer
Warning

Follow these guidelines to avoid injuring yourself or damaging the printer.

For safety information, go to Appendix “A–User Safety” in this guide.

Follow these guidelines to move the printer within the office or to prepare the printer for 
shipment.

LED Behavior Description

Blinking Green Warming up

Displaying menus

Canceling a job

Waiting for more data

Processing data

Printing pages

Steady Green Ready to print

Steady Orange A major error has occurred and printing has 
stopped

Blinking Orange A minor error exists that prevents further printing 
without user attention

LED is off Power is off

Power Saver mode
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Precautions for Moving the Printer

Caution
Remove the print cartridge prior to moving the printer. Failure to do so can result in 
damage to the printer.

Moving the Printer Within the Office
The printer can be safely moved from one location within an office to another as long as it 
travels in an upright position, gently. Any jarring movement, such as pushing the printer over a 
raised door threshold or across a parking lot, can damage the printer.

Caution
Remove the print cartridge prior to moving the printer. Failure to do so can result in 
damage to the printer.

Preparing the Printer for Shipment
To transport the printer by vehicle, a printer must be repackaged in the original packaging or a 
repackaging kit. Instructions for repackaging the printer are provided in the repackaging kit.

If you do not have the original packaging, or are unable to repackage the printer, contact your 
local Xerox service representative.

Use one or two people to lift the printer.
Always turn off the printer using the 
power switch, and unplug all cables and 
cords.
Disconnect and remove the optional 
500-Sheet Feeder if present.
Always lift the printer from the 
designated lift points.
Do not place any food or liquids on the 
printer.
Damage to the printer caused from 
improper moving or failure to repackage 
the printer properly for shipment, is not 
covered by the warranty, service 
agreement, or Total Satisfaction 
Guarantee. The Total Satisfaction 
Guarantee is available in the United 
States and Canada. Coverage may vary 
outside these areas; please contact your 
local representative for details.
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Additional Resources

Support
There is additional help available at www.xerox.com/office/3500support. You can access the 
Knowledge Base and technical support via email and driver downloads.

A set of Xerox links is installed in your web browser’s Favorites folder when you install the 
printer drivers on your computer. The Troubleshooting tab in your Windows printer driver 
also includes useful links.

Web Links
Xerox provides many resources to help you learn more about your Xerox printer. Use these 
web sites to obtain information about your printer.

Resource Link

To link to product information, download printer 
drivers, view documents, and access support 
information:

www.xerox.com/office/3500support

To view technical support information: www.xerox.com/office/3500support

To order Xerox supplies: www.xerox.com/office/3500supplies

To find your local sales and support center: www.xerox.com/office/contacts

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Order&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3500&PgName=Tech&Language=english
http://www.office.xerox.com/cgi-bin/world_contact.pl
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Appendices
A–User Safety
Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information will ensure the continued safe operation 
of your printer.

Electrical Safety
Use the power cord supplied with your printer.
Plug the power cord directly into a properly grounded electrical outlet. Make sure each 
end of the card is securely connected. If you do not know if an outlet is grounded, ask an 
electrician to check the outlet.
Do not use a ground adapter plug to connect the printer to an electrical outlet that does not 
have a ground connection terminal.
Do not use an extension cord or power strip.
Verify that the printer is plugged into an outlet that is capable of providing the correct 
voltage and power. Review the printer’s electrical specifications with an electrician, if 
necessary.

Warning
Avoid the potential of electrical shock by ensuring that the printer is properly grounded. 
Electrical products may be hazardous if misused.

Do not place the printer in an area where people might step on the power cord.
Do not place objects on the power cord.
Do not block the ventilation openings. These openings are provided to prevent 
overheating of the printer.
Do not drop paper clips or staples into the printer.

Warning
Do not push objects into slots or openings on the printer. Making contact with a voltage 
point or shorting out a part could result in fire or electrical shock.

If you notice unusual noises or odors:

1. Turn off the printer immediately

2. Disconnect the power cord from the electrical outlet 

3. Call an authorized service representative to correct the problem.
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The power cord is attached to the printer as a plug-in device at the back of the printer. If it is 
necessary to disconnect all electrical power from the printer, disconnect the power cord from 
the electrical outlet.

Warning
Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are specifically instructed to do so. Power should be OFF when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are no 
parts that you can maintain or service behind these covers.

Note
Leave the printer on for optimum performance; it does not pose a safety hazard.

The following are hazards to your safety:

The power cord is damaged or frayed.
Liquid is spilled into the printer.
The printer is exposed to water.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

Laser Safety
With specific regard to lasers, this printer complies with laser product performance standards 
set by governmental, national, and international agencies and is certified as a Class 1 Laser 
Product. The printer does not emit hazardous light because the beam is totally enclosed during 
all modes of customer operation and maintenance.

Maintenance Safety
Do not attempt any maintenance procedure that is not specifically described in the 
documentation supplied with your printer.
Do not use aerosol cleaners. The use of supplies that are not approved may cause poor 
performance and could create a hazardous condition.
Do not burn any of the consumables or routine maintenance items. For information on 
Xerox supplies recycling programs, go to www.xerox.com/gwa.

Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements. These 
include safety agency examination, approval, and compliance with established environmental 
standards.

www.xerox.com/gwa


A–User Safety

Phaser® 3500 Laser Printer
46

Your attention to the following safety guidelines helps to ensure the continued, safe operation 
of your printer.

Printer Supplies
Use the supplies specifically designed for your printer. The use of unsuitable materials 
may cause poor performance and a possible safety hazard.
Follow all warnings and instructions marked on, or supplied with, the printer, options and 
supplies.

Printer Location
Place the printer in a dust-free area where the temperature range is 50 degrees F to 
89 degrees F (10 degrees C to 32 degrees C) and the relative humidity range of 20 percent 
to 80 percent. 
Place the printer in an area where there is adequate space for ventilation, operation, and 
servicing. The recommended minimal spacing is 32 cm (12.6 in.) behind and 10 cm (4 in.) 
on each side of the printer. 
Do not block or cover the slots and openings on the printer. The printer may overheat 
without adequate ventilation.
For altitudes under 2,050 meters (6,726 ft.), use the Low Altitude setting. For altitudes 
over 2,050 meters (6,726 ft.), use the High Altitude setting.
Do not place the printer near a heat source.
Do not place the printer in direct sunlight.
Do not place the printer in line with the cold air flow from an air conditioning system.
Place the printer on a level, solid surface with adequate strength for the weight of the 
printer. The base printer weight without any packaging materials is approximately 17 kg 
(38 lb.).

Moving the Printer
Refer to “Moving and Repacking the Printer” on page 41.

Printing Safety Guidelines
Wait 10-15 seconds between turning the printer off and on.
Keep hands, hair, neckties, etc., away from the exit and feed rollers.
Do not remove the paper source tray that you selected in either the printer driver or control 
panel when the printer is printing.
Do not open the doors when the printer is printing.
Do not move the printer when the printer is printing.
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Symbols Marked on the Product
Hot surface on or in the printer. Use caution to avoid personal injury.

Use caution (or draws attention to a particular component). 

B–Printer Specifications (English Only)

Physical Specifications
Width: 396 mm (15.6 in.)

Depth: 453 mm (17.8 in.)

Height: 348 mm (13.7 in.)

Top Clearance: 254 mm (10 in.)

Weight: 17 kg (38 lb.)

Environmental Specifications

Temperature
Storage (in original packaging): -20°  to 40° C / -4°  to 104° F
Operating: 10°  to 32° C / 50°  to 89° F



B–Printer Specifications (English Only)

Phaser® 3500 Laser Printer
48

Relative Humidity
Storage (in original packaging): 10% to 90%
Operating: 20% to 80%

Electrical Specifications
Available in two models:

110-127 VAC, 50/60 Hz
220-240 VAC, 50/60 Hz

Performance Specifications

Resolution
300 x 300 dpi
600 x 600 dpi
1200 dpi Image Quality

Print Speed
Up to 35 pages per minute (ppm)

Fuser Life
Maximum 150,000 pages

Controller Specifications
400 MHz processor

Memory
32 MB standard on all printers
Maximum 288 MB

Page Description Languages (PDL)
PCL5e (driver not included)
PCL6
PostScript
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Resident Fonts
PostScript 3: 136 fonts
PCL: 45 scalable fonts, 1 bitmap font

Interfaces
USB
IEEE 1284 parallel
Ethernet 10BaseT and 100BaseTx

C–Regulatory Information (English Only)
Xerox has tested this product to electromagnetic emission and immunity standards. These 
standards are designed to mitigate interference caused or received by this product in a typical 
office environment.

United States (FCC Regulations)
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with 
these instructions, it may cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:

Reorient or relocate the receiver.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected.
Consult the dealer or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox could void the user's authority 
to operate the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded 
interface cables.

Canada (Regulations)
This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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European Union (Declaration of Conformity)
Xerox Corporation declares, under our sole responsibility, that the product to which this 
declaration relates is in conformity with the following standards and other normative 
documents:

Low Voltage Directive 73/23/EEC as amended

Electromagnetic Compatibility Directive 89/336/EEC as amended

Radio & Telecommunications Terminal Equipment Directive 1999/5/EC as amended

This product, if used properly in accordance with the user's instructions, is neither dangerous 
for the consumer nor for the environment.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox.

D–Material Safety Data Sheet (English Only)
For Material Safety Data information regarding your Phaser 3500 printer, go to 
www.xerox.com/office/msds. For the Customer Support Center phone numbers, see the 
information sheet that shipped with your printer or go to www.xerox.com/office/contacts. 

EN 60950:2000

EN 60825-1:1994+A1:2001+A2:2002

EN 55022:1998+A1:2000+A2:2003

EN 55024:1998+A1:2001+A2:2003

EN 61000-3-2:2000

EN 61000-3-3:1995+A1:2001

EN 300 330-2 V1.1.1

EN 300 440-2 V1.1.1

EN 301 489-3 V1.3.1

http://www.office.xerox.com/products/msds.html
http://www.office.xerox.com/cgi-bin/world_contact.pl
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E–Product Recycling and Disposal (English Only)
Xerox operates a worldwide equipment takeback and reuse/recycle program. Contact your 
Xerox sales representative (1-800-ASK-XEROX) to determine whether this Xerox product is 
part of the program. For more information about Xerox environmental programs, visit 
www.xerox.com/environment.html.

If your product is not part of the Xerox program and you are managing its disposal, please note 
that the product may contain lead and other materials whose disposal may be regulated due to 
environmental considerations. For recycling and disposal information, contact your local 
authorities. In the United States, you may also refer to the Electronic Industries Alliance at 
www.eiae.org.

www.xerox.com/environment.html
www.eiae.org
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PCL6 print driver, 15
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setting, 14
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Canada, 49
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web links, 43
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safety

altitude, 46
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Status Monitor, 8
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supported papers, 12
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guidelines, 23
printing from Tray 1 (MPT), 23
printing from Tray 2 or 3, 24

Tray 1 (MPT)
manual 2-sided printing, 22
manual feed mode, 17
printing custom size paper, 28
printing transparencies, 23

tray sequence, 9
troubleshooting

cleaning the printer, 40
control panel messages, 40
error and warning messages, 41
Knowledge Base, 43
LED descriptions, 41
moving and repacking the printer, 41
print-quality problems, 40
Status Monitor, 8

typefaces, 10

U
user safety, 44

W
Walk-Up technology, 5
warning messages, 3, 34, 41
watermarks, 33
web links, 43
Windows

PCL driver settings, 15
PostScript driver settings, 16
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